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GroupWise-to-Outlook

Migration Training

(Desktop M365 Outlook Application)

Welcome!
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Training duration = 90 minutes

• Be present.

• You can use Q&A to ask questions.

• We will “parking lot” questions that require 

further research.

• Training, reference materials, and support 

contact information are available at: 

https://tncourts.gov/microsoft-migration
(Password: L4wtech24)

Class Logistics and Guidelines Intro

https://tncourts.gov/microsoft-migration


Lesson 1

Purpose

Introduce the Microsoft Outlook tool and available 

support resources.

Course Objectives

Upon completion of this course, you will be able 

to describe:

• Outlook capabilities.

• How to send, receive, reply, and manage 

email. 

• How to create and manage meeting 

invitations. 

• How to delegate and work with shared 

calendars and mail.

• Where to access job aids and help videos.  

Course Objectives Intro
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# Lesson Name Duration

1 Introduction and Outlook Overview 10 min.

2 Email Basics 10 min.

3 Managing Views and Email 15 min.

4 Calendar and Meeting Basics 15 min.

5 Sharing and Delegation 30 min.

6 Next Steps and Support Resources 5 min.

Course Overview Intro
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Objective: At the end of this lesson, 

you will be able to describe . . .

• Benefits of moving to Outlook

• How to access Outlook  

• How to navigate Outlook at the 

highest level:

• Menu/Ribbon structure

• Mail 

• Calendar

• Global search (very powerful!)

Introduction and Outlook Overview Lesson 1
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Benefits of Outlook Lesson 1

Improved integration with other state 
agencies

User-friendly, streamlined interface

Updated technology and security

Prepares the way for greater collaboration 
via other Microsoft apps

Demonstrates our commitment to be 
forward-thinking and responsive to change. 



Access Outlook (desktop version) Lesson 1
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1. Double-click the Outlook 

desktop shortcut. 

Result: The application displays.

Note: Mobile access is available for 

those who currently have mobile 

access. Those who are interested can 

contact the helpdesk to request it. 

Access occurs through the Outlook 

app on the App Store or Google Play. 

 

Demo



Outlook Navigation Lesson 1

A primary feature in all 

Microsoft Office applications 

(Outlook, Word, Excel, 

PowerPoint) is the “ribbon.”

Just like hanging pot and 

utensil holders, ribbons 

enable you to find the tool 

you want without hunting 

through cabinets.
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Outlook Navigation Lesson 1

Menu / Ribbon

App 

Selector

Hide 

Ribbon

Mail Folders / 

Shared Calendars



Calendar Navigation + Shared Calendars Lesson 1
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Search Mail and Calendar Lesson 1

12

By default, you are searching all Mail 

folders and subfolders. 

1. Type a search term or phrase.

2. Press ENTER on your keyboard. 

Result: Matching items are displayed.

3

1

4

Demo

However, you MAY search just a specific 

mail folder, or Calendar items only (as 

shown at left), or All Outlook Items. 

3. Click Calendar in the App Selector. 

4. Enter search terms and press ENTER.

Result: Only calendar items appear. 



Knowledge 
Check
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Which of the following is a correct 

statement about ribbons in Outlook? 

A. Ribbons are an advanced feature that few 

people use in Outlook.

B. Leaving ribbons displayed is recommended. 

It makes it easier to find buttons and tasks 

you can perform. 

C. Ribbons refer to awards you receive when 

you use Outlook correctly for 90 days. 

Lesson 1



Lesson 1Email Basics Lesson 2

Objective: At the end of this lesson, 

you will be able to describe . . .

• How to create and send email

• Use the global address book

• Set up Automatic Replies (out of 

office)

• Create a new contact or contact 

group

• Create your email signature

Duration: About 10 minutes

145/20/2024



Terminology Changes Lesson 2
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GroupWise Term Outlook Term

Distribution List Contact Group



Create and Send Email - Overview Lesson 2

1. Choose New Email to start a new 

message.

2. Enter a name or email address in 

the To and Cc fields (details 

provided on next slides).

3. In Subject, type the subject of 

the email message.

4. Place the cursor in the body of 

the email message to create your 

message.

5. Click Format Text menu if you 

need to change fonts, add 

bullets, indent, etc.

6. After finishing your message, 

click Send.

4
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1

5

6 2

3



Type Names Directly in the To or Cc 

Lines

Lesson 2

To select one or more contacts:

1. Type first few letters of first or 

last name in the To or Cc line.

Frequently used contacts appear 

first. Other names from your 

organization appear next.

Note: To add a Bcc, you must click the 

Options menu, then Bcc (see below).

17

1



Use the Global Address Book Lesson 2

To select one or more contacts:

1. Click the To button.

2. Search for a person using first or last 

name, then click the right-arrow 

button.

3. Click To, Cc or Bcc to add them to 

the email, then click OK. 

Tip: Change the Address Book to your 

own Contacts to access names that you 

manage outside of the organizational 

directory. 

18

1 Tip2

3

Demo



Set up Automatic Replies (Out-of-Office) Lesson 2

1. Click the File menu (not shown). 

2. Click Automatic Replies (Out-of-

Office). 

3. Click the Send automatic replies 

radio button. (Check Only send 

during this time range, if you want 

to specify and start and end time for 

replies.)

4. Complete the Inside My 

Organization section with the desired 

message to your own organization. 

Copy that message (Ctrl + c) before 

moving on to step 5. 

5. Click Outside My Organization and 

paste the above message; modify if 

needed. 

6. Click OK. 

19

2 3

Demo



Create a New Contact Lesson 2

1. Click People. 

2. Click New Contact.

3. Add desired information. 

4. Click Save & Close to create 

only one contact (or Save & 

New to create another). 

20

1

2

4



Create a Contact Group Lesson 2

1. Click People. 

2. Click New Contact Group.

3. Enter a Name for your group.

4. Click Add Members (or double-

click in the “We didn’t find anything 

to show here” field).

Result: Options appear to either select 

from your personal Outlook Contacts or 

from the Address Book (which is the 

official set of TN Courts contacts). 

5. Enter the desired first or last name 

into the Search field, then click the 

arrow (or press ENTER). 

6. Select the desire person’s name and 

click the Members button to add 

them to the list, and then click OK.

7. Repeat as needed, and then click 

Save & Close. 

21

1

2

Demo

3

4

5

6

7



Set up Signature in Outlook Lesson 2

22

1. Click the File menu (not shown). 

2. Click Options (lower-left)

3. Click Mail. 

4. Click Signatures.

(Continued next page)

3

4

2



Set up Signature in Outlook (continued) Lesson 2

23

Continued from previous page:

5. Click New. 

6. Enter desired signature name in 

New Signature text field 

(not shown). 

7. Type or paste signature into 

text block. 

Tip: You can add images and 

hyperlinks via buttons at right. 

8. Click Save.

Tip: See that you can enter a 

different signature for new 

messages vs. replies/forwards!

5

8

7

Demo

First Name Last Name 
TN Administrative Office of the Courts
511 Union St., Suite 600, Nashville, TN 37219
Phone 615.741.2687 ext. 4709

Web https://tncourts.gov/

Email First.LastName@tncourts.gov
Mission: To serve as a trusted resource to assist in improving the administration of justice and 
promoting confidence in the Judiciary.

https://tncourts.gov/boards-commissions/boards-and-commissions/integrated-criminal-justice-steering-committee
mailto:First.LastName@tncourts.gov


Knowledge 
Check

24

Which of the following capabilities does 

Outlook support?  

A. You can blind-copy emails (Bcc), but you 

have to click Options to enable it. 

B. You can set up different Automatic Replies 

for tncourts.gov and non-tncourts.gov email 

addresses. 

C. You can type directly into the To line of a 

new email to display common contacts. 

D. You can have multiple signatures. 

E. All of the above

Lesson 2



Lesson 1Managing Views and Email Lesson 3

Objective: At the end of this lesson, 

you will be able to describe how to . . .

• Modify views

• How to create and move mail 

folders

• Print an email

• Organize and manage email using 

rules, categories, colors, flags, etc.

Duration: About 15 minutes

255/20/2024



Terminology Changes Lesson 3
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GroupWise Term Outlook Term

Home Outlook does not have a Home page; 

however, the Outlook View ribbon enables 

users to select layout preferences.

Categories Outlook also uses Categories, but for some 

features, Outlook uses the term Tags.

Junk Mail Junk Email

Trash Deleted Items

Cabinet Inbox is similar to the GroupWise Cabinet.

Open/Hide (folder pane) Expand/Pin/Minimize (folder pane)



Modify the Outlook View Lesson 3

27

1. Click Mail, if needed. 

2. Select the View ribbon.

3. In the Layout group, select desired 

options in the Folder Pane, Reading 

Pane, and To-Do Bar. 

Tip: Common preferred settings are:

Arrangement: Date (Conversations)

Folder Pane: Normal (if you file email)

Reading Pane: Right

To-Do Bar: Only Calendar

                 selected, as shown

1 2

3



Pin or Un-pin Folders Lesson 3
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2
1

This works in either Calendar or Mail. 

1. Click the tiny right-arrow (hover 

message says: Click to Expand 

Folder Pane). 

2. Click the Pin button.

Result: The folders stay visible until 

you click the tiny left-arrow (hover 

message says: Minimize the Folder 

Pane.)

Demo



Create a New Mail Folder Lesson 3

29

1. Click Mail, if needed. 

2. Right-click on Inbox (or a different 

folder, as desired)

Result: A blank text box appears 

below the item selected.

3. Enter a Name for the folder.

4. Press ENTER on your keyboard. 

Tip: You can drag email from the 

reading pane into any folder. 

1

2
3

Right-click

Demo



Print an Email (or save as PDF) Lesson 3

30

1. Click File menu (not shown).

2. Click Print (far left).

3. Click the large Print button (if 

the desired printer is showing 

the Printer field). 

Notes: Microsoft Print to PDF 

enables you to save as a PDF 

file. 

You can also select the drop-

down arrow to the right of the 

Printer field to change the 

printer (shown at left). 

2

3

Demo



Apply Tags (Reminders to take action) Lesson 3

31

1. Select the email you wish to tag.

2. Click Home ribbon, if needed. 

3. Click Tags. 

4. Select Follow-up for a list of 

options to apply to the selected 

email. 

Tip: Categories are helpful to 

associate emails. Follow-ups 

help you manage your time. 

2
3

A job aid is 
available for 
these steps. 

Demo



Create and Manage Rules Lesson 3

32

1. Click Home ribbon, if needed. 

2. Click Rules. 

3. Click New Rule. 

4. Create from a wizard or from 

scratch (see red arrow). 

Tip: The possibilities are nearly 

infinite. Whatever you want to 

do, you can create a rule to 

manage it. 

4

21

3



Knowledge 
Check

33

What’s the quickest way to get your 

calendar be displayed on the right side 

of Outlook, beside your email?  

A. Mail → View → To-Do Bar → Calendar

B. Search Google for “Display calendar on right side of 

mail inbox in Outlook”

C. Ask your colleague. 

Lesson 3



Lesson 1Calendar and Meeting Basics Lesson 4

Objective: At the end of this lesson, 

you will be able to describe how to . . .

• Change calendar views/colors

• Create a new meeting

• Add Zoom link/info

• Add AOC Resources (e.g., a room)

• Check participants’ availability

• Add recurrence

• View tracking responses

• Respond to meeting invitations

• Propose new meeting times

Duration: About 15 minutes 34



Terminology Changes Lesson 4
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GroupWise Term Outlook Term

Busy Search Scheduling Assistant

Propose New Time Propose Time



Change Calendar Views Lesson 4
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1

2

1. Click Calendar, 

if needed. 

2. Click desired 

timeframe in the 

Arrange group.

3. If you wish to 

color-code 

meetings, right-

click a meeting 

and select a 

Category color.

3

Demo



Create a New Meeting: The Basics Lesson 4

37

1. From Calendar, click the Home 

ribbon, if needed. 

2. Click New Meeting. 

3. Enter the following: 

1. Title

2. Required and Optional participants

3. Start time and End time

4. Update Location (or Schedule a 

Meeting button for Zoom).

5. Enter content (and click Format 

Text if you need to modify fonts, 

bullets, etc.).

6. Click Send. 

(More details next page.)

4

2

3

5

6

1

5



Zoom and Physical Locations Lesson 4

38

Let’s discuss:

• Zoom – For those who have ZoomGov 

accounts, it is much easier to add Zoom 

meetings as the location than before. 

• Only AOC users can use the AOC 

conference rooms. Non-AOC user may 

have access to other conference rooms. 

• Do NOT schedule conference rooms 

through shared calendar (proxy). Use 

the method shown here to schedule the 

meeting first, then add Location. 



Use Scheduling Assistant (Busy Search) Lesson 4
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From a new meeting window:

1. Click Scheduling Assistant.

2. Use the scroll bar to move the 

times and dates, as needed until 

you find a slot that is suitable 

for all participants. 

Note: As you move the selection 

window, the Start and End 

date/times automatically 

update.

3. Optional: Return to Meeting 

tab to make other changes, add 

an agenda, etc. 

 

1

2

3

Demo



Make Meeting Recurring Lesson 4
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1

From a new meeting window:

1. Click Make Recurring.

2. Edit Recurrence pattern as needed. 

3. Edit Range of recurrence.

4. Click OK. 

2

3

4



View Tracking of Participant Responses Lesson 4
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1. Double-click the desired meeting 

from the calendar (not shown).

2. Click Tracking.

3. View Response column to see 

whether Attendees have 

responded. Options include: 

• None

• Accepted

• Tentative

• Declined

2

3

Demo



Respond to Meeting Invitation Lesson 4
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1. Single-click the invitation in Mail.

Result: The preview of your 

calendar shows the proposed 

date/time with other meetings. 

2. Click the Accept, Tentative, or 

Decline buttons, as appropriate.  

1

Tip: The Clock button 

enables you to propose 

a new time. 

2



Propose New Meeting Time Lesson 4

43

1. Click elsewhere in the same date or move 

the horizontal scroll bar (very tiny, under 

the grid) and select new meeting time.

2. Confirm date/time displayed look correct. 

3. Click Propose Time. 

Result: New Time Proposed draft is 

displayed. 

4. Add a message (optional) and click Send. 

1

3

Scroll bar

4

Demo



Knowledge 
Check
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When you want to respond to a meeting 

invitation by proposing a different time 

or date, which of the following is true?

A. You CANNOT view all invited parties’ 

schedules. Only the organizer’s.

B. You CAN view all invited parties’ schedules, 

so that you can propose a time when 

everyone is available.

C. You can only reply to the organizer with an 

email requesting your preferred time.

Lesson 4



Lesson 1Sharing and Delegation Lesson 5

Objective: At the end of this lesson, 

you will be able to describe how to . . .

• View a shared calendar

• Share your own calendar

• Delegate mail and calendar access

• Share mail folders or calendars with 

a working group

• Request admin-created Shared 

Mailboxes, when necessary

Duration: About 30 minutes

45



Terminology Changes Lesson 5
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GroupWise Term Outlook Term

Shared Mail or Shared 

Calendar 

(same term in Outlook)

Proxy

Shared Mailbox or Shared Calendar (Owned 

by one user, but permission is given so others 

can view or even edit items)

Note: Some shared mailboxes (which include 

mail and calendar), are set up by admins and 

function more like a GroupWise proxy.

Delegate (Initiated by owner; causes mail and 

calendar items to be sent by another “on 

behalf of” you. You can change the settings so 

they appear to be coming directly from you.



Delegates vs. Shared Mail and Calendars Lesson 5

47

Delegate

Your car Not you, but behaves as if 

it’s you behind the wheel—

and the driver can do 

anything (if given permission).  

Shared Mail or Calendar

Your car You allow someone along 

for the ride to watch or do 

one thing at a time. 



Accept Access to a Shared Calendar Lesson 5
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When someone 

shares their 

calendar with you, 

you receive an 

email notification. 

You must click 

Accept before you 

can access it. 

The level of access 

is described. 



View a Shared Calendar Lesson 5
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1. Click Calendar button, if needed.

2. Under Shared Calendars, click the checkbox in 

front of the desired calendar name. 

Result: The additional calendar appears to the 

right of your own calendar. 

2

1



Share Your Own Calendar with Others Lesson 5

50

1. Click Calendar button, if needed. 

2. Click Share Calendar.

3. Select the Calendar in the drop-down list.

4. Click Add… then select the person with whom you 

want to share your calendar (already selected here).

5. Select the appropriate Permissions radio button. 

6. Click OK. 

Result: The person will receive the email inviting 

them to Accept your calendar. 

21

3

4

5

6
Demo



Send Calendar Info via Email (not sharing) Lesson 5

51

1. Open a new email.

2. Go to Insert → Calendar; a pop-up 

displays for the details.

3. Select the Date Range from the drop-

down.

4. Use the Details drop-down to select the 

permissions.

5. Select Advanced options if necessary.

6. Click OK (not shown).

7. Complete the email with instructions to 

the recipient, because this email is their 

ONLY notification. 

Note: Only dates in the range are included 

in the email.

2

3

3

4

5

Demo



Delegate Mail and Calendar Access (1 of 5) Lesson 5

52

Read only

Reviewer

Complete control: 

• Read anything

• Create, Edit, 

Delete anything, 

including items 

you created

Author

• Read anything

• Create, Edit, 

Delete items 

they create, but 

not yours

Editor

Use delegation to enable someone to do things on your 

behalf so that incoming emails and meetings are sent from 

your account: “Sent by John Doe on behalf of Jane Doe.”

Delegation levels include: 



Delegate Mail and Calendar Access (2 of 5) Lesson 5
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1. Click File (not shown here).

2. Go to Account Settings…

3. Click Delegate Access.

Result: The Delegates popup 

window displays (see next page).

3

2



Delegate Mail and Calendar Access (3 of 5) Lesson 5
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4. Click Add…, then select the person to 

whom you want to delegate (using the 

Address Book, not shown here)

Result: The Delegate Permissions: 

[name you just selected] box appears.

5. Assign appropriate permissions to 

each of the following: Calendar, Tasks, 

Inbox, Contacts, Notes. 

6. [Recommended]: Check the 1
st
 check 

box, “Automatically send a message to 

delegate…”

7. Click OK. 

Notice the Tip. It is important if you 

don’t want to delegate to see your 

whole Inbox. 

Tip: As long as this 
first radio button is 
selected, you 
receive copies of 
invitations and 
responses so you 
can stay in the loop. 

4

6
7

5



Delegate Mail and Calendar Access (4 of 5) Lesson 5

55Demo



Modify or Remove Delegate (5 of 5) Lesson 5
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1. Click File (not shown 

here).

2. Go to Account 

Settings…

3. Click Delegate Access.

4. Select delegate’s name 

(if multiple). 

5. Click Remove to 

remove the delegate 

altogether, or click 

Permissions… to 

modify permissions. 

3

2

Demo



Share a Mail Folder (1 of 2) Lesson 5
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To get the process started:

1. In Mail, right-click the 

folder with your name. 

2. Click Folder Permissions.

3. Select existing or Add… 

new contact; then select 

that person. 

4. Select a Permission Level 

(which comprises various 

presets) OR select desired 

Read and Write options. 

5. Make sure Folder visible 

is checked.

Note: Additional steps are 

required. See Sharing a 

folder in Outlook support 

document on migration 

landing page. 

1
Right-
click

2

3

4

5

https://tncourts.gov/microsoft-migration
https://tncourts.gov/microsoft-migration


Access a Shared Mail Folder (2 of 2) Lesson 5
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Note: Users do NOT receive email 

notification that a folder was 

shared with them. They must 

complete these steps:

1. Click File → Account 

Settings → Account 

Settings (not shown). 

2. Click Data Files → Settings 

→ Advanced. 

3. Click Add… and type name 

of user who shared their mail 

folder with you. 

4. Click OK and OK again. 

Note: Additional steps are 

required. See Sharing a 

folder in Outlook support 

document on migration 

landing page. 

2

3

4

Leave 
these 

checkbox 

settings. 

https://tncourts.gov/microsoft-migration
https://tncourts.gov/microsoft-migration


When to Request a Shared Mailbox Lesson 5

59

In the following situations, ask an IT admin to 

set up a shared mailbox: 

• The shared mail/calendar is intended to 

help people coordinate access or 

communicate about a particular topic.

• The shared mail/calendar will be used 

by multiple people for a long time. 

• Persons needing access may change 

over time (revolving door) and you 

want it to be easy to update. 

For example, the 5-county 

district 24 needs to share 

judge(s)’ calendars to 

coordinate docket 

scheduling.



Knowledge 
Check

60

Which of the following best describes the 

difference between sharing a calendar or 

mail folder and delegating account 

permissions?

A. Sharing is permanent. You can never change 

it or remove it. Delegation can be removed.

B. Sharing only allows viewing; users cannot 

edit. Delegation allows editing or authoring.

C. Sharing is nice when you have a large bag of 

M&Ms. 

D. Delegation enables you to assign multiple or 

even all permissions at the same time.

Lesson 5
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Objective: At the end of this lesson, 

you will be able to describe . . .

• Where you can access support 

resources

• How to contact IT support after 

you migrate

• Reminder regarding events 

leading up to migration

Next Steps and Course Summary Lesson 6



Stop:

Using GroupWise after you migrate.

What’s Changing?

Start:

Using Outlook for all calendar, email, and contact 

management. 

62

Continue:

Using GroupWise Messenger.



Support Resources Lesson 6
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TN Courts Support Resources

Visit https://tncourts.gov/microsoft-migration 

(password: L4wtech24) to access the following: 

• AOC-specific Outlook training videos (four, about 

5 min each)

• This training PowerPoint as a PDF

• Outlook Basics job aid (3 pages)

• Outlook Rules and Delegation job aid (2 pages)

• How to install iPhone/Android Outlook app

• FAQs (frequently asked questions)

How to contact IT support: 

outlook365@tncourts.gov

800-448-7980

Microsoft-produced videos/support documentation 

Email

Create, send, and reply to email

Create an email signature

Send and receive email attachments

Recall or replace a sent email

Search and filter email

Set categories, flags, and reminders

Organize email by adding folders and moving email to folders

Set up email handling rules (basic)

Manage email with rules (advanced)

Delegate email and calendar access (allow someone else to access and send emails 

and calendar invitations/responses) [no video]

Calendar

Add a contact (personal address book)

Create a personal contact group (personal distribution list)

Overview of the Outlook Calendar

Create a meeting invitation or appointment

Share your calendar with one or more people and assign certain permissions

Use calendar categories and reminders

Create an additional calendar (to separate appointments or to share) [no video]

[continued next page]

https://tncourts.gov/microsoft-migration
mailto:outlook365@tncourts.gov
https://support.microsoft.com/en-us/office/create-send-and-reply-to-an-email-400d4d45-8e2d-46a2-8cb5-ddabf12489ed
https://support.microsoft.com/en-us/office/create-an-email-signature-31fb24f9-e698-4789-b92a-f0e777f774ca
https://support.microsoft.com/en-us/office/send-and-receive-attachments-d32cd5ad-c7c5-49df-814d-4c17a5d3beb0
https://support.microsoft.com/en-us/office/recall-or-replace-a-sent-email-8e564127-15a0-4cf6-b974-f2101f5e256e
https://support.microsoft.com/en-us/office/search-and-filter-email-3e32b06d-a2d9-4a66-922f-78b77c41b97f
https://support.microsoft.com/en-us/office/set-categories-flags-or-reminders-a894348d-b308-4185-840f-aff63063d076
https://support.microsoft.com/en-us/office/organize-email-by-using-folders-0616c259-4bc1-4f35-807d-61eb59ac79c1
https://support.microsoft.com/en-us/office/set-up-rules-in-outlook-75ab719a-2ce8-49a7-a214-6d62b67cbd41
https://support.microsoft.com/en-us/office/manage-email-messages-by-using-rules-c24f5dea-9465-4df4-ad17-a50704d66c59
https://support.microsoft.com/en-us/office/manage-another-person-s-mail-and-calendar-items-afb79d6b-2967-43b9-a944-a6b953190af5
https://support.microsoft.com/en-us/office/manage-another-person-s-mail-and-calendar-items-afb79d6b-2967-43b9-a944-a6b953190af5
https://support.microsoft.com/en-us/office/add-a-contact-in-outlook-1ef8f35b-04be-4bd0-ac9c-6d6a146887ce
https://support.microsoft.com/en-us/office/create-a-contact-group-in-outlook-3f73d218-52d6-4f88-a733-9ff37073ee4c
https://support.microsoft.com/en-us/office/welcome-to-your-outlook-calendar-6fb9225d-9f9d-456d-8c81-8437bfcd3ebf?wt.mc_id=otc_outlook
https://support.microsoft.com/en-us/office/create-appointments-and-meetings-6e6ddec6-5983-4c42-9652-b99e120206fb
https://support.microsoft.com/en-us/office/share-your-calendar-in-outlook-2fcf4f4f-8d46-4d8b-ae79-5d94549e531b
https://support.microsoft.com/en-us/office/use-calendar-categories-and-reminders-in-outlook-59230c47-6fe9-46bd-8646-e1118e9eb973
https://support.microsoft.com/en-us/office/create-additional-calendars-4b5570c4-e95d-4673-b38a-2b8ead5f00ee
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Microsoft-produced support videos and step-by-step documentation 

(continued)

Contacts

Add a contact

Create a contact group

Tasks

Create tasks and a to-do list

Mobile

Use Outlook for mobile devices (iOS and Android) (first in a series of links for mobile)

https://support.microsoft.com/en-us/office/add-a-contact-in-outlook-1ef8f35b-04be-4bd0-ac9c-6d6a146887ce?wt.mc_id=otc_outlook
https://support.microsoft.com/en-us/office/create-a-contact-group-in-outlook-3f73d218-52d6-4f88-a733-9ff37073ee4c
https://support.microsoft.com/en-us/office/create-tasks-and-a-to-do-list-in-outlook-6de6ee52-751b-4405-b389-850572b15306
https://support.microsoft.com/en-us/office/setup-outlook-for-ios-and-android-5a8bb76e-9bcb-4cf0-ae94-bda414104d16
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14 days 

before you 

migrate

7 days 

before you 

migrate

• You receive an email 

notifying you of your 

specific go-live date. 

• You are reminded of 

actions you must 

complete. 

• You receive a 

reminder of your go-

live date. 

• You are directed to 

complete critical 

tasks you MUST do.

• Reset password according to 
new standards

• Set up authentication with a 
mobile device (text or phone)

• Log into Microsoft 365 for the 
first time. 

Your go-

live day!

• You log into Outlook 

with your new 

password. 

• You receive a go-live 

Welcome email with 

support reminders.



Lesson 1

Now that you have completed this course, you 

should be able to describe:

• Outlook capabilities.

• How to send, receive, reply, and manage 

email. 

• How to create and manage meeting 

invitations. 

• How to delegate and work with shared 

calendars and mail (proxies).

• Where to access job aids, support documents, 

and IT support.

• What to expect in the coming weeks.  

Summary Intro

GroupWise to Outlook Migration 

Course Summary
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